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Application Note 

デザインモデル 

LTspiceⓇモデルの使い方 

ROHM では電気回路シミュレーション用の LTspice モデルを提供しています。このアプリケーションノートでは LTspice にモデルを追加する方法につ

いて説明しています。 
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1. モデル入手方法 

Step 1 

- ROHM ホームページにアクセスし、TOP ページの右上にある「サイト検索」窓に製品形名を入力します。 

 

Step 2 

- 検索結果から該当する形名をクリックします。 
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Step 3 

- 製品ページが表示されるので、「モデルとツール」をクリックします。 

- 「モデルとツール」までスクロールするので、LTspice Model を見つけてクリックします。 

 

 

Step 4 

- 「使用許諾」が表示されるので、「同意」にチェックを入れ、「ダウンロード」をクリックするとファイルがダウンロードされます。 

  

Click 

Check 

スクロール 
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2. モデルの種類 

モデルには「デバイスモデル」と「サブサーキットモデル」の2種類があります。ダウンロードしたファイルをテキストエディターで開くと構文を確認することがで

きます。デバイスモデルはバイポーラトランジスタやダイオードなど、単素子を対象としたモデルで、構文は「.MODEL」で始まっています。サブサーキット

モデルはMOSFETやSiCパワーデバイス、IGBTなど、複数の素子で構成されているモデルで、構文は「.SUBCKT」で始まり「.ENDS」で終わってい

ます。サブサーキットモデルの中でも、MOSFETは受動素子、能動素子、電源で構成された等価回路で表現したマクロモデルで記述されています。

そのため複数の「.MODEL」が存在します。SiCパワーデバイスやIGBTはデバイス特性を任意の数式で表現したビヘイビアモデルで記述されています。 

モデルの種類 デバイスモデル サブサーキットモデル 

先頭のコマンド .MODEL .SUBCKT 

主なデバイス バイポーラトランジスタ 

ダイオード 

LED 

MOSFET（マクロモデル） 

ツェナーダイオードの一部（ビヘイビアモデル） 

TVS ダイオードの一部（マクロモデル、ビヘイビアモデル） 

SiC パワーデバイス（ビヘイビアモデル） 

GaN パワーデバイス（ビヘイビアモデル） 

IGBT（ビヘイビアモデル） 

双方向 TVS ダイオード（マクロモデル） 

デジタルトランジスタ（マクロモデル） 

ダーリントントランジスタ（マクロモデル） 

異種複合トランジスタ（マクロモデル） 

半導体レーザー（ビヘイビアモデル） 

構文例 * Q2SC4081UB NPN BJT model 
* Date: 2006/11/30 
.MODEL Q2SC4081UB NPN 
+ IS=70.000E-15 
+ BF=277.08 
+ VAF=114.03 
+ IKF=1 
+ ISE=70.000E-15 
+ NE=1.8934 
+ BR=11.565 
+ VAR=100 
+ IKR=.11266 
+ ISC=1.0228E-12 
+ NC=1.3260 
+ NK=.71869 
+ RE=.2 
+ RB=13.897 
+ RC=1.2190 
+ CJE=11.342E-12 
+ MJE=.38289 
+ CJC=4.0230E-12 
+ MJC=.34629 
+ TF=338.92E-12 
+ XTF=4.0449 
+ VTF=167.36 
+ ITF=.85959 
+ TR=110.25E-9 
+ XTB=1.5000 

マクロモデル 

* R6006JNX NMOSFET model 
* PKG: TO-220FM,Vdss=600V,Id=6A 
* Rds(on)=0.72Ω,Qg=15.5nC 
* Model Generated by ROHM 
* All Rights Reserved 
* Date: 2017/07/27 
*****************D G S 
.SUBCKT R6006JNX 1 2 3 
M1   11 22 3 3 MOS_N 
D1         3 1 DDS 
R1        1 11 RTH 697.2m 
D2       22 11 DDG 
R2        2 22 14.8 
.MODEL MOS_N NMOS 
+ LEVEL=3 
+ L=2.0000E-6 
+ W=1 

     : (略) 

+ KAPPA=0 
+ NFS=36G 
.MODEL DDS D 
+ IS=2.2476E-6 
+ N=2.1699 

     : (略) 

+ BV=600 
+ TT=70n 
.MODEL DDG D 
+ CJO=172.09E-12 
+ M=3.3976 

     : (略) 

+ FC=0.11 
+ T_ABS=25 
.MODEL RTH RES 
+ TC1=0.0073 
+ TC2=0.0200E-3 
.ENDS R6006JNX 

ビヘイビアモデル 

* SCT4018KR SiC NMOSFET model 
* TO247-4L 
* 1200V 90A 18mOhm 
* Model Generated by ROHM 
* All Rights Reserved 
* DATE:2022/02/03 
******************D G S DS 
.SUBCKT SCT4018KR 1 2 3 4 
.PARAM T0=25 
* 
.FUNC R1(I)     
{18.49m*I*EXP((TEMP-T0)/207.9*EXP((TE
MP-T0)/880))+905.2n*I*ABS(I)**1.745*E
XP((TEMP-T0)/160.2*EXP((TEMP-T0)/348.
4))} 
.FUNC R2(I)     
{5*MAX(I,0)+5*MIN(I,0)} 
.FUNC V1(V,W)   
{V-67.95m*ASINH(W/17.87m)*EXP((TEMP-T
0)/-323.4)-270.9m*ASINH(W/693.3m)*EXP
((TEMP-T0)/-260.5)-43.83m*W*EXP((TEMP
-T0)/3.368k)} 
     : 

     : (略) 

     : 
V12 52 53 0 
C11 53  1 1p 
G11 52  1 
VALUE={I11(MIN(MAX(V(52,1),-4.5k),3.6
))+I(V12)*C11(MAX(V(52,1),625.6m),MIN
(V(52,1),625.6m))} 
R11 52  1 1T 
.ENDS SCT4018KR 
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3. LTspice のファイル構成 

LTspice をインストールすると Figure 1 のような構成でファイルが生成されます。モデルファイルやシンボルファイルが関係するフォルダーは、

¥LTspice¥lib 下の ¥cmp, ¥sub, ¥sym フォルダーになります。¥cmp フォルダーは標準の部品ライブラリー群が格納されており、これらはデバイス

モデルで作られています。¥sub フォルダーは標準部品以外のライブラリーが格納されており、主にサブサーキットモデルで作られています。もちろんデバ

イスモデルも格納可能です。¥sym フォルダーは回路図シンボルファイルが格納されています。¥sub フォルダーのモデルファイルと¥sym フォルダーの回

路図シンボルファイル(.asy)は、回路図で使用できるように関連付けられています。 

この後、モデルを追加する方法をいくつか説明しますが、方法ごとに格納するフォルダーが変わりますので、これらのフォルダー構成を覚えておいてくださ

い。 

C:¥Users¥%USERNAME%¥AppData¥Local¥LTspice¥lib 

                                                   ¥cmp : 標準部品ライブラリー群を格納（デバイスモデル） 

                                                        ¥standard.bead : フェライトビーズ 

                                                        ¥standard.bjt : バイポーラトランジスタ 

                                                        ¥standard.cap : コンデンサ 

                                                        ¥standard.dio : ダイオード 

                                                        ¥standard.ind : インダクタ 

                                                        ¥standard.jft : JFET 

                                                        ¥standard.mos : MOSFET 

                                                        ¥standard.res : 抵抗 

                                                   ¥sub : 上記以外のライブラリーを格納（サブサーキットとデバイスモデル） 

                                                        ¥xxxxxxxx.sub : sub ファイル 

                                                        ¥xxxxxxxx.lib : lib ファイル 

                                                   ¥sym : 回路図シンボルファイルを格納 

                                                        ¥xxxxxxxx.asy : 回路図シンボル 

Figure 1. LTspice のフォルダー構成とライブラリー群 
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デバイスモデル編 

4. デバイスモデルの確認 

ROHM 製品では、バイポーラトランジスタ、ダイオード、LED でデバイスモデルを提供しています。ダウンロードしたモデルをテキストエディターで開いて

構文が「.MODEL」で始まっていることを確認してください。 

5. デバイスモデルを追加する方法 

ここでは 3 種類の方法を説明しますが、それぞれにメリットとデメリットがありますので、自分に合った方法を選んでください。 

 方法 1 

LTspice の標準部品ライブラリーに

追加する 

方法 2 

回路図にモデル情報を記述する 

方法 3 

任意の部品フォルダーにモデルを格

納する 

大まかな手順 1. 標準ライブラリーを開く 

2. 標準ライブラリーに追加するモ

デルファイルをテキストでコピーす

る 

3. 回路図にシンボルを配置する 

4. 部品リストからモデルを選択す

る 

1. 回路図にシンボルを配置する 

2. “SPICE directive” に追加

するモデルファイルをテキストでコ

ピーする 

3. 回路図にモデルテキストを配置

する 

4. シンボルの属性を変更する 

1. 追加するモデルファイルを格納

する 

2. 回路図にシンボルを配置する 

3. シンボルのモデル名を変更する 

4. “.lib” ファイルを読み込むコマ

ンドを回路図に書く 

メリット - 部品リストから選択できる - 回路図に部品のパラメータが表示

されているので、回路図だけでシミ

ュレーションのエビデンスを確認で

きる 

- 回路図データだけあればシミュレー

ションできるので PC 環境に依存

しない 

- フォルダーを使って分類できるので

部品の管理がしやすい 

デメリット - LTspice を再インストールしたと

き、標準ライブラリーが上書きされ

るので追加したモデルは削除され

る 

- 回路図上の文字が多くなる 

- 回路図ごとに部品のパラメータを

管理しないといけない 

- PC 環境が変わると、モデルファイ

ルの環境設定をやり直さないとい

けない 

 

以降では、それぞれの方法について、より詳しく手順を説明します。 

 

  



 

8/55 

© 2022-2025 ROHM Co., Ltd. No. 65AN064J Rev.005 

2025.3 

Application Note LTspice モデルの使い方 

5-1. 方法 1：LTspice の標準部品ライブラリーに追加する 

1. “File > Open” をクリックします。 

2. “Open an existing file” が開くので、 “C:¥Users¥%USERNAME%¥AppData¥Local¥LTspice¥lib¥cmp” へ移動します。 

ファイルタイプは “Discretes” を選択します。 

3. 追加する部品に応じて、下記のファイルを選択します。この例では NPN トランジスタモデル “2sc4081ub.lib” を追加します。 

- バイポーラトランジスタ: standard.bjt 

- ダイオード: standard.dio 

- LED: standard.dio 

4. “Open” をクリックします。 

 

 

  

1 

2-1 

3 

4 

2-2 
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5. “standard.bjt” が開きました。 

 

6. 追加したいモデルをテキストエディター（メモ帳など）で開きます。 

7. 中身を “standard.bjt” の最終行へコピーします。このとき不要なコメント行は削除してもかまいません。 

8. “File > Save” をクリックして上書き保存します。これでモデルが追加されました。 

注意：LTspice のコンポーネントライブラリが更新されると、このフォルダーのファイルは上書きされたり削除されたりする可能性があります。更新

前にファイルをバックアップする必要があります。 

 

 

       

6 

8 

コメント行 

7 
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次は回路図にトランジスタを配置します。 

9. ツールバーの “Component” アイコンをクリックし “Component select window” を開きます。 

10. 一覧から “npn” を選択して “Place” をクリックします。なお、PNP トランジスタの場合は “pnp” を、ダイオードの場合は “diode” を、

LED の場合は “LED” を選択します。 

  

11. 回路図に配置したら、コンポーネント上で右クリックします。 

12. プロパティウィンドウが開くので “Pick New Transistor” をクリックします。 

13. “Select Bipolar Transistor” ウィンドウが開くので、先に追加した “Part No.” を選択します。 

14. 回路図のモデル名が変更され、これで設定は終了です。 

 

     

  

  

9 

10-1 

10-2 

11 
12 

13 

14 
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5-2. 方法 2：回路図にモデル情報を記述する 

この例では NPN トランジスタモデル “2sc4081ub.lib” を追加します。 

1. まず回路図にトランジスタを配置します。ツールバーの “Component” アイコンをクリックし “Component select window” を開きます。 

2. 一覧から “npn” を選択して “OK” をクリックします。なお、PNP トランジスタの場合は “pnp” を、ダイオードの場合は “diode” を、LED

の場合は “LED” を選択します。 

3. 回路図に配置します。 

   

4. 追加したいモデルをテキストエディター（メモ帳など）で開きます。 

5. ツールバーの “SPICE Directive” をクリックすると入力ウィンドウが開きます。 

6. モデルの中身をコピーし、“OK” をクリックします。このとき不要なコメント行は削除してもかまいません。 

       

1 

2-1 

2-2 

3 

4 

5 

6-2 

コメント行 
6-1 
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7. 回路図の適当な場所にモデルテキストを配置します。 

8. トランジスタの “NPN” 上で右クリックします。 

9. 入力ウィンドウが開くので、“NPN” をモデル名に書き換え、“OK” をクリックします。 

10. 回路図のモデル名が変更され、これで設定は終了です。 

 

 

 

 

 

 

  

7 

8 

10 

9-2 

9-1 
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5-3. 方法 3：任意の部品フォルダーにモデルを格納する 

標準でインストールされているモデルと追加したモデルを区別するために任意のフォルダーを作って格納することや、回路図と同じフォルダーに格納する

こともできます。このように、モデルを管理しやすい場所に格納して使うことができます。 

モデルを格納するフォルダーの例 

a. アプリケーションデータフォルダー : C:¥Users¥%USERNAME%¥AppData¥Local¥LTspice¥lib¥sub 

*これは推奨しません。LTspice のコンポーネントライブラリが更新されると、このフォルダーのファイルは上書きされたり削除されたりする可能性が

あります。 

b. 回路図と同じフォルダー  : D:¥project-a¥test_circuit ← 例 

c. 任意のフォルダーー   : C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥MyLib ← 例 

       : C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥ROHM ← 例えば会社名 

       : E:¥LTspicemodel¥transistor¥ROHM ← 例 

この例では任意のフォルダーに NPN トランジスタモデル “2sc4081ub.lib” を格納した場合で説明します。 

1. “C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥MyLib” フォルダーに追加したいモデルを格納します。 

 

 

 

  

1 
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2. 回路図にトランジスタを配置します。ツールバーの “Component” アイコンをクリックし “Component select window” を開きます。 

3. 一覧から “npn” を選択して “Place” をクリックします。なお、PNP トランジスタの場合は “pnp” を、ダイオードの場合は “diode” を、

LED の場合は “LED” を選択します。 

4. 回路図に配置します。 

 

 

  

5. トランジスタの “NPN” 上で右クリックします。 

6. 入力ウィンドウが開くので、“NPN” をモデル名に書き換え、“OK” をクリックします。モデル名は “.lib” ファイルを開いて、“.MODEL” 行に書

かれているモデル名を入力します。 

7. 回路図のモデル名が変更されました。 
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次に “.lib” ファイルを読み込むコマンドを回路図に書きます。 

8. ツールバーの “Directive” をクリックすると入力ウィンドウが開きます。 

9. 入力欄に “.lib <filename>” を記述します。<filename>は、部品フォルダーに格納した “ファイル名” であり、直前に回路シンボルに

付けた “モデル名” ではないので注意してください。<filename>の記述方法は、モデルの格納場所によって変わりますので、詳細は下記を

参照してください。入力が終わったら “OK” をクリックします。 

また、 “.lib” 以外に “.include” 、 “.inc” コマンドも使用できます。 

構文  .lib <filename> 

   .include <filename> 

   .inc <filename> 

 

 

 

モデルの格納場所により <filename> の記述が変わります。 

a. 回路図と同じフォルダー: D:¥project-a¥test_circuit ← 例 

   → “ファイル名” のみ記述 

    構文例: .lib 2sc4081ub.lib 

b. 任意のフォルダー : C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥MyLib ← 例 

   → “絶対パス” と “ファイル名” を記述 

    構文例: .lib C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥MyLib¥2sc4081ub.lib 

上記 b のケースで、“ファイル名” のみ記述することもできます。この場合は次ページのように、デバイスモデルファイルの格納場所を定義する必要が

あります。この方法の方が便利です。 

  

8 

9 

9 



 

16/55 

© 2022-2025 ROHM Co., Ltd. No. 65AN064J Rev.005 

2025.3 

Application Note LTspice モデルの使い方 

10. “.lib” ファイルを読み込むコマンドを回路図の適当な場所に配置して設定は完了です。 

 

これ以降の作業は前ページの b ケースで、“.lib” 構文に “ファイル名” のみ記述する場合に実施してください。 

デバイスモデルファイルの格納場所を定義します。 “.lib” 構文にモデル格納場所の絶対パスを記述するよりも、この方法のほうがモデルの格納場

所が変更になった場合に、Settings ダイアログで一括変更できるので便利です。 

11. ツールバーの “Settings” アイコンをクリックします。 “Settings Dialog” の “Search Paths” タブを開きます。 

12. “Simulation Library Search Path[*]” 欄にサーキットモデルファイルを格納しているフォルダーのパスを記述します。 

任意のフォルダー: C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥MyLib ← 例 

    → “絶対パス” を記述 

     記述例: C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥MyLib 

13. 入力が終わったら “OK” をクリックして設定は終了です。 
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サブサーキットモデル編 

6. サブサーキットモデルの確認 

ROHM 製品では、MOSFET、SiC パワーデバイス、IGBT でサブサーキットモデルを提供しています。ダウンロードしたモデルをテキストエディターで開

いて構文が「.SUBCKT」で始まっているとこを確認してください。 

7. サブサーキットモデルを追加する方法 

ここでは 2 種類の方法を説明しますが、それぞれに長所と短所がありますので、自分に合った方法を選んでください。 

 方法 1 

回路図にモデル情報を記述する 

方法 2 

任意の部品フォルダーにモデルを格納する 

大まかな手順 1. 回路図にシンボルを配置する 

2. “SPICE directive” に追加するモデルファイルをテキ

ストでコピーする 

3. 回路図にモデルテキストを配置する 

4. シンボルの属性を変更する 

1. 追加するモデルファイルをフォルダーに格納する 

2. 回路図シンボルを作成する 

3. シンボルとモデルファイルを関連付ける 

4. シンボルとモデルファイルの格納場所を定義する 

5. 回路図にシンボルを配置する 

長所 - 回路図に部品のパラメータが表示されているので、回路

図だけでシミュレーションのエビデンスを確認できる 

- 回路図データだけあればシミュレーションできるので PC

環境に依存しない 

- フォルダーを使って分類できるので部品の管理がしやすい 

短所 - 回路図上の文字が多くなる 

- 回路図ごとに部品のパラメータを管理しないといけない 

- 回路図シンボルの作成、シンボルとモデルファイルの関連

付けなどの作業が必要 

- PC 環境が変わると、シンボルとモデルファイルの環境設

定をやり直さないといけない 

 

この後、方法ごとに詳細な手順を説明します。 
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7-1. 方法 1：回路図にモデル情報を記述する 

この例では Nch MOSFET “r6006jnx.lib” を追加します。 

1. まず回路図にシンボルを配置します。ツールバーの “Component” アイコンをクリックし “Component select window” を開きます。 

2. 一覧から “nmos” を選択して “Place” をクリックします。また Pch MOSFET の場合は “pmos” を選択します。なお、一覧にないシンボ

ルは作成する必要があるので、方法は後で説明します。 

3. 回路図に配置します。 

  

4. 追加したいモデルをテキストエディター（メモ帳など）で開きます。 

5. ツールバーの “SPICE Directive” をクリックすると入力ウィンドウが開きます。 

6. モデルの中身をコピーし、“OK” をクリックします。このとき不要なコメント行は削除してもかまいません。 
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7. 回路図の適当な場所にモデルテキストを配置します。 

8. 回路シンボル上で、“ctrl + 右クリック” します。 

9. “Component Attribute Editor” が開くので、各属性を変更します。 

-  “Prefix” をサブサーキットモデルの場合は “X” に書き換えます。 

-  “Value” をサブサーキットモデルファイルの “. SUBCKT” 構文に記述されている “モデル名” に書き換えます。 

10. “Open Symbol” をクリックし、サブサーキットモデルファイル (r6006jnx.lib) と回路シンボル (nmos.asy) のピン配置が一致しているか

確認します。 
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11. Nch MOSFET シンボル (nmos.asy) が新しいタブで開きます。 

12. シンボルの Drain pin 上で右クリックすると “Pin/Port Properties” ウィンドウが開くので、“Label” と “Netlist Order” を確認します。 

13. 同様に Gate と Source ピンも確認します。結果は下記のようになり、D, G, S の順に 1, 2, 3 となっていることが確認できました。 

Label: D Netlist Order: 1 

Label: G Netlist Order: 2 

Label: S Netlist Order: 3 
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14. サブサーキットモデルファイル (r6006jnx.lib) に記述されている順番を確認します。左から D, G, S であり、シンボルの設定と同じであること

が確認できました。 

15. なお、r6006jnx.lib に記述されている、“.SUBCKT R6006JNX 1 2 3” 構文の “1 2 3” はサブサーキットのノード番号であって 

“Netlist Order” の数字とは関係ありませんので注意してください。 

16. また、“Netlist Order” の数字は Datasheet に記載されているピン番号ではありませんので注意してください。 

17. メニューバーの “File” > “Close” でシンボルを閉じて、設定は終了です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

16 Datasheet に記載されているピン番号 17-2 

15 
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7-2. 方法 2：任意の部品フォルダーにモデルを格納する 

標準でインストールされているモデルと追加したモデルを区別するために任意のフォルダーを作って格納することや、回路図と同じフォルダーに格納する

こともできます。このように、モデルを管理しやすい場所に格納して使うことができます。 

モデルを格納するフォルダーの例 

a. 回路図と同じフォルダー  : D:¥project-a¥test_circuit ← 例 

b. 任意のフォルダーー   : C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥MyLib ← 例 

       : C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥ROHM ← 例えば会社名 

       : E:¥LTspicemodel¥transistor¥ROHM ← 例 

この例では任意のフォルダーに Nch MOSFET モデル “r6006jnx.lib” を格納した場合で説明します。 

1. “C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥MyLib” フォルダーに追加したいモデルを格納します。 
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回路図シンボルを、標準で用意されている回路図シンボルを流用して作成します 

2. “C:¥Users¥%USERNAME%¥AppData¥Local¥LTspice¥lib¥sym” フォルダー内の “nmos.asy” を任意のフォルダーへコピーします。

なお、流用できるシンボルがないものは作成する必要があるので、方法は後で説明します。 

3. “R6006JNX.asy” に名前を変更します。ここではサブサーキットモデルファイル名と同じにしていますが、同名にする必要はなく、使用者が認

識できる名前でかまいません。 

 

 

 

 

 

 

 

 

 

 

4. “R6006JNX.asy” を LTspice で開き、メニューバーから “Edit > Attributes > Edit Attributes” を選択します。 

 

 

 

 

 

 

 

 

 

5. “Symbol Attribute Editor” が開くので、各属性を変更します。 

-  “Prefix” をサブサーキットモデルの場合は “X” に書き換えます。 

-  “Value” をサブサーキットモデルファイルの “. SUBCKT” 構文に記述されている “モデル名” に書き換えます。 

-  “ModelFile” にサブサーキットモデルファイル名を入力します。 

6. “OK” をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

  

2 3 

4 

C:¥Users¥%USERNAME%¥AppData¥Local¥LTspice¥lib¥sym 

任意のフォルダーへコピーする。例えば、 
C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sym¥MySym 

5-1 

5-2 

5-3 
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7. これで回路シンボルが “R6006JNX” に変更されました。 

 

 

 

 

 

 

 

 

 

次に、サブサーキットモデルファイル (r6006jnx.lib) と回路シンボル (R6006JNX.asy) のピン配置が一致しているか確認します。 

8. シンボルの Drain pin 上で右クリックするとプロパティウィンドウが開くので、 “Label” と “Netlist Order” を確認します。 

9. 同様に Gate と Source ピンも確認します。結果は下記のようになり、D, G, S の順に 1, 2, 3 となっていることが確認できました。 

Label: D Netlist Order: 1 

Label: G Netlist Order: 2 

Label: S Netlist Order: 3 
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10. サブサーキットモデルファイル (r6006jnx.lib) に記述されている順番を確認します。左から D, G, S であり、シンボルの設定と同じであること

が確認できました。もし異なる場合は “Netlist Order” の順番を変更します。 

11. なお、r6006jnx.lib に記述されている、“.SUBCKT R6006JNX 1 2 3” 構文の “1 2 3” はサブサーキットのノード番号であって 

“Netlist Order” の数字とは関係ありませんので注意してください。 

12. また、“Netlist Order” の数字は Datasheet に記載されているピン番号ではありませんので注意してください。 

13. メニューバーの “File > Save” で保存後、“File > Close” でシンボルを閉じて確認は終了です。 
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シンボルファイルの格納場所を定義します。 

この例のように、シンボルファイルを任意の場所に格納する場合は定義する必要があります。 

14. ツールバーの “Settings” アイコンをクリックします。 “Settings Dialog” の “Search Paths” タブを開きます。 

15. “Symbol Search Path[*]” 欄に回路シンボルを格納しているフォルダーのパスを記述します。 

任意のフォルダー: C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sym¥MySym ← 例 

    → “絶対パス” を記述 

     記述例: C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sym¥MySym 

16. 入力が終わったら “OK” をクリックします。 
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サブサーキットモデルファイルの格納場所を定義します。 

この例のようにサブサーキットモデルファイルを任意の場所に格納する場合は定義する必要があります。 

17. ツールバーの “Settings” アイコンをクリックします。 “Settings Dialog” の “Search Paths” タブを開きます。 

18. “Library Search Path[*]” 欄にサーキットモデルファイルを格納しているフォルダーのパスを記述します。パスの記述方法は下記のように格

納場所によって変わります。 

a. 回路図と同じフォルダー : D:¥project-a¥test_circuit ← 例 

       → 定義不要 

b. 任意のフォルダー  : C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥MyLib ← 例 

      → “絶対パス” を記述 

        記述例: C:¥Users¥%USERNAME%¥Documents¥LTspice¥lib¥sub¥MyLib 

 

19. 入力が終わったら “OK” をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

上記以外に、“.lib”、“.include”、“.inc” 構文を使って、フォルダーの場所を記述して回路図上に配置する方法がありますが、モデルの格納

場所が変更になった場合に、“Settings Dialog” で定義した方が一括で変更できるので便利です。 
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回路図に回路シンボルを配置します。 

20. ツールバーの “Component” アイコンをクリックし “Component select window” を開きます。 

21. 一覧から先ほど作成した “R6006JNX” を選択します。追加した新しいシンボルが表示されないことがあります。そのときは “Refresh” ボタ

ンをクリックすると表示されます。 

22. “Place” をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

23. 回路図に配置して終了です。 
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補足：サブサーキットモデルファイル (.lib) と回路シンボル (.asy) のピン配置を一致するときの注意点 

トランジスタなどピン数が少ないデバイスでは、ネットリストや回路シンボルのプロパティウィンドウの中に “1 2 3” という数字が出てきます。また

Datasheet の内部回路図にも “1 2 3” が記載されています。これらの数字はすべて違う意味を持っていますので、同一視してしまうと誤った設定

になるため注意してください。 

それぞれの数字の意味を下表にまとめました。モデルファイルの数字はサブサーキットのノード番号で、シンボルの Netlist Order や製品のピン番号

とは違うものです。この例ではノード番号が偶然、D が 1、G が 2、S が 3 になっているため、よりピン番号と勘違いする状況になっています。回路シ

ンボルの “Netlist Order” の数字は、ネットリストに記述されているピンの順番を示しています。”1” とはネットリストの一番左のピンは、この例では 

“D” ですという意味になります。同様に、”2” とはネットリストの左から 2 番目のピンは “G” 、”3” とはネットリストの左から 3 番目のピンは “S” 

となります。Datasheet の内部回路図に掲載している数字は製品のピン番号で物理的なピン配置に使う数字です。 

モデルファイル（ネットリスト） 回路シンボル Datasheet 内部回路図 

サブサーキットのノード番号 ネットリストに記述されているピンの順番 製品のピン番号 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ピン配置を一致させる内容をまとめると下図になります。1. サブサーキットモデルファイルに記述されているピンの順番と回路図シンボルの “Netlist 

Order” の順番を一致させます。2. Datasheet に掲載されている物理的なピン配置をシンボルの情報として示したいときは “Label” の部分へ

定義します。 
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8. 回路図シンボルの作成方法 

SiC MOSFET や IGBT など、標準で用意されていないシンボルを作成します。“Draw” ツールを使って 1 から作成しても良いですが、この方法は

時間がかかるため、予め用意されたシンボルファイル (.asy) から作成する方法を説明します。この資料の後に付録として回路シンボルファイルを掲

載していますので、その中から必要なシンボルを選んで作成してください。 

1. テキストエディター (メモ帳) で新規ファイルを開き、付録の中から作成したいシンボルのテキストデータ部分をコピーします。 
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2. シンボルに対応するサブサーキットモデルをテキストエディターで開き、“.SUBCKT” 構文に記述されている “モデル名” をシンボルファイルの 

“SYMATTR Value” 構文の値に記述します。 

3. シンボルファイルの “SYMATTR ModelFile” 構文の値に、サブサーキットモデルのファイル名を記述します。 

 

サブサーキットモデルファイル (.lib)                                  作成中のシンボルファイル (.asy) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. シンボルファイルを、拡張子が “.asy” となるように適当な名前で (例. SCT4018KR.asy) 保存して、シンボル作成は終了です。 
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付録 1 回路シンボルファイル 

“SiC MOSFET 3pin” 

シンボル： 

 

 

 

 

 

シンボルファイル名：SiCmosfet-3.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 48 48 48 96 
LINE Normal 32 48 32 48 
LINE Normal 48 32 48 0 
LINE Normal 48 32 48 32 
LINE Normal 32 32 48 32 
LINE Normal 32 64 48 64 
LINE Normal 24 64 24 32 
LINE Normal 0 64 24 64 
LINE Normal 48 71 64 71 
LINE Normal 68 53 60 53 
LINE Normal 64 45 68 53 
LINE Normal 60 53 64 45 
LINE Normal 68 45 60 45 
LINE Normal 48 25 64 25 
LINE Normal 64 71 64 25 
LINE Normal 32 54 32 42 
LINE Normal 32 38 32 26 
LINE Normal 32 70 32 58 
LINE Normal 46 42 37 48 
LINE Normal 46 54 37 48 
LINE Normal 32 48 48 48 
CIRCLE Normal 85 86 9 8 
WINDOW 0 96 32 Left 2 
WINDOW 3 96 72 Left 2 
SYMATTR Value SCTxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM SiC MOSFET 
SYMATTR ModelFile xxxx.lib 
PIN 48 0 NONE 0 
PINATTR PinName D 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 48 96 NONE 0 
PINATTR PinName S 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 2 回路シンボルファイル 

“SiC MOSFET 3pin（電気-熱連成解析モデル）” 

シンボル： 

 

 

 

 

 

シンボルファイル名：SiCmosfet-3-therm.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 48 48 48 96 
LINE Normal 32 48 32 48 
LINE Normal 48 32 48 0 
LINE Normal 48 32 48 32 
LINE Normal 32 32 48 32 
LINE Normal 32 64 48 64 
LINE Normal 24 64 24 32 
LINE Normal 0 64 24 64 
LINE Normal 48 71 64 71 
LINE Normal 68 53 60 53 
LINE Normal 64 45 68 53 
LINE Normal 60 53 64 45 
LINE Normal 68 45 60 45 
LINE Normal 48 25 64 25 
LINE Normal 64 71 64 25 
LINE Normal 32 54 32 42 
LINE Normal 32 38 32 26 
LINE Normal 32 70 32 58 
LINE Normal 46 42 37 48 
LINE Normal 46 54 37 48 
LINE Normal 32 48 48 48 
RECTANGLE Normal 288 96 160 16 
CIRCLE Normal 85 86 9 8 
WINDOW 0 96 32 Left 2 
WINDOW 3 96 0 Left 2 
SYMATTR Value SCTxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM SiC MOSFET 
SYMATTR ModelFile xxxx.lib 
PIN 48 0 NONE 0 
PINATTR PinName D 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 48 96 NONE 0 
PINATTR PinName S 
PINATTR SpiceOrder 3 
PIN 192 96 BOTTOM 8 
PINATTR PinName Tj 
PINATTR SpiceOrder 4 
PIN 256 96 BOTTOM 8 
PINATTR PinName Ta 
PINATTR SpiceOrder 6 
PIN 288 32 RIGHT 8 
PINATTR PinName Tc 
PINATTR SpiceOrder 5 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 3 回路シンボルファイル 

“SiC MOSFET 4pin” 

シンボル： 

 

 

 

 

 

シンボルファイル名：SiCmosfet-4.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 48 48 48 96 
LINE Normal 32 48 32 48 
LINE Normal 48 32 48 0 
LINE Normal 48 32 48 32 
LINE Normal 32 32 48 32 
LINE Normal 32 64 48 64 
LINE Normal 24 64 24 32 
LINE Normal 0 64 24 64 
LINE Normal 48 71 64 71 
LINE Normal 68 53 60 53 
LINE Normal 64 45 68 53 
LINE Normal 60 53 64 45 
LINE Normal 68 45 60 45 
LINE Normal 48 25 64 25 
LINE Normal 48 80 0 80 
LINE Normal 64 71 64 25 
LINE Normal 32 54 32 42 
LINE Normal 32 38 32 26 
LINE Normal 32 70 32 58 
LINE Normal 46 42 37 48 
LINE Normal 46 54 37 48 
LINE Normal 32 48 48 48 
CIRCLE Normal 85 86 9 8 
WINDOW 0 96 32 Left 2 
WINDOW 3 96 72 Left 2 
SYMATTR Value SCTxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM SiC MOSFET 
SYMATTR ModelFile xxxx.lib 
PIN 48 0 NONE 0 
PINATTR PinName D 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 48 96 NONE 0 
PINATTR PinName S 
PINATTR SpiceOrder 3 
PIN 0 80 NONE 8 
PINATTR PinName DS 
PINATTR SpiceOrder 4 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 4 回路シンボルファイル 

“SiC MOSFET 4pin（電気-熱連成解析モデル）” 

シンボル： 

 

 

 

 

 

シンボルファイル名：SiCmosfet-4-therm.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 48 48 48 96 
LINE Normal 32 48 32 48 
LINE Normal 48 32 48 0 
LINE Normal 48 32 48 32 
LINE Normal 32 32 48 32 
LINE Normal 32 64 48 64 
LINE Normal 24 64 24 32 
LINE Normal 0 64 24 64 
LINE Normal 48 71 64 71 
LINE Normal 68 53 60 53 
LINE Normal 64 45 68 53 
LINE Normal 60 53 64 45 
LINE Normal 68 45 60 45 
LINE Normal 48 25 64 25 
LINE Normal 48 80 0 80 
LINE Normal 64 71 64 25 
LINE Normal 32 54 32 42 
LINE Normal 32 38 32 26 
LINE Normal 32 70 32 58 
LINE Normal 46 42 37 48 
LINE Normal 46 54 37 48 
LINE Normal 32 48 48 48 
RECTANGLE Normal 288 96 160 16 
CIRCLE Normal 85 86 9 8 
WINDOW 0 96 32 Left 2 
WINDOW 3 96 0 Left 2 
SYMATTR Value SCTxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM SiC MOSFET 
SYMATTR ModelFile xxxx.lib 
PIN 48 0 NONE 0 
PINATTR PinName D 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 48 96 NONE 0 
PINATTR PinName S 
PINATTR SpiceOrder 3 
PIN 0 80 NONE 8 
PINATTR PinName DS 
PINATTR SpiceOrder 4 
PIN 192 96 BOTTOM 8 
PINATTR PinName Tj 
PINATTR SpiceOrder 5 
PIN 288 32 RIGHT 8 
PINATTR PinName Tc 
PINATTR SpiceOrder 6 
PIN 256 96 BOTTOM 8 
PINATTR PinName Ta 
PINATTR SpiceOrder 7 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 5 回路シンボルファイル 

“IGBT” 

シンボル： 

 

 

 

 

 

シンボルファイル名：IGBT.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 64 8 64 0 
LINE Normal 64 8 64 8 
LINE Normal 24 64 24 32 
LINE Normal 0 64 24 64 
LINE Normal 64 96 64 88 
LINE Normal 32 54 32 42 
LINE Normal 32 38 32 26 
LINE Normal 32 70 32 58 
LINE Normal 64 8 32 32 
LINE Normal 64 88 32 64 
LINE Normal 53 64 32 48 
LINE Normal 47 70 49 77 
LINE Normal 43 78 49 77 
LINE Normal 56 20 50 19 
LINE Normal 52 12 50 19 
WINDOW 0 80 32 Left 2 
WINDOW 3 80 72 Left 2 
SYMATTR Value RGxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM IGBT 
SYMATTR ModelFile xxxx.lib 
PIN 64 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 64 96 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 6 回路シンボルファイル 

“IGBT（電気-熱連成解析モデル）” 

シンボル： 

 

 

 

 

 

シンボルファイル名：IGBT-therm.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 64 8 64 0 
LINE Normal 64 8 64 8 
LINE Normal 24 64 24 32 
LINE Normal 0 64 24 64 
LINE Normal 64 96 64 88 
LINE Normal 32 54 32 42 
LINE Normal 32 38 32 26 
LINE Normal 32 70 32 58 
LINE Normal 64 8 32 32 
LINE Normal 64 88 32 64 
LINE Normal 53 64 32 48 
LINE Normal 47 70 49 77 
LINE Normal 43 78 49 77 
LINE Normal 56 20 50 19 
LINE Normal 52 12 50 19 
RECTANGLE Normal 272 96 144 16 
WINDOW 0 80 32 Left 2 
WINDOW 3 80 0 Left 2 
SYMATTR Value RGxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM IGBT 
SYMATTR ModelFile xxxx.lib 
PIN 64 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 64 96 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
PIN 176 96 BOTTOM 8 
PINATTR PinName Tj 
PINATTR SpiceOrder 4 
PIN 272 32 RIGHT 8 
PINATTR PinName Tc 
PINATTR SpiceOrder 5 
PIN 240 96 BOTTOM 8 
PINATTR PinName Ta 
PINATTR SpiceOrder 6 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 7 回路シンボルファイル 

“IGBT ファストリカバリーダイオード内蔵” 

シンボル： 

 

 

 

 

 

シンボルファイル名：IGBT-frd.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 64 8 64 0 
LINE Normal 64 8 64 8 
LINE Normal 24 64 24 32 
LINE Normal 0 64 24 64 
LINE Normal 80 88 80 8 
LINE Normal 64 8 80 8 
LINE Normal 64 96 64 88 
LINE Normal 64 88 80 88 
LINE Normal 88 55 72 55 
LINE Normal 80 39 88 55 
LINE Normal 72 55 80 39 
LINE Normal 88 39 72 39 
LINE Normal 32 54 32 42 
LINE Normal 32 38 32 26 
LINE Normal 32 70 32 58 
LINE Normal 64 8 32 32 
LINE Normal 64 88 32 64 
LINE Normal 53 64 32 48 
LINE Normal 47 70 49 77 
LINE Normal 43 78 49 77 
LINE Normal 56 20 50 19 
LINE Normal 52 12 50 19 
WINDOW 0 96 32 Left 2 
WINDOW 3 96 72 Left 2 
SYMATTR Value RGxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM IGBT 
SYMATTR ModelFile xxxx.lib 
PIN 64 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 64 96 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 8 回路シンボルファイル 

“IGBT ファストリカバリーダイオード内蔵（電気-熱連成解析モデル）” 

シンボル： 

 

 

 

 

 

シンボルファイル名：IGBT-frd-therm.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 64 8 64 0 
LINE Normal 64 8 64 8 
LINE Normal 24 64 24 32 
LINE Normal 0 64 24 64 
LINE Normal 80 88 80 8 
LINE Normal 64 8 80 8 
LINE Normal 64 96 64 88 
LINE Normal 64 88 80 88 
LINE Normal 88 55 72 55 
LINE Normal 80 39 88 55 
LINE Normal 72 55 80 39 
LINE Normal 88 39 72 39 
LINE Normal 32 54 32 42 
LINE Normal 32 38 32 26 
LINE Normal 32 70 32 58 
LINE Normal 64 8 32 32 
LINE Normal 64 88 32 64 
LINE Normal 53 64 32 48 
LINE Normal 47 70 49 77 
LINE Normal 43 78 49 77 
LINE Normal 56 20 50 19 
LINE Normal 52 12 50 19 
RECTANGLE Normal 352 96 160 16 
WINDOW 0 96 32 Left 2 
WINDOW 3 96 0 Left 2 
SYMATTR Value RGxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM IGBT 
SYMATTR ModelFile xxxx.lib 
PIN 64 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 64 96 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
PIN 192 96 BOTTOM 8 
PINATTR PinName Tjm 
PINATTR SpiceOrder 4 
PIN 256 96 BOTTOM 8 
PINATTR PinName Tjd 
PINATTR SpiceOrder 5 
PIN 352 32 RIGHT 8 
PINATTR PinName Tc 
PINATTR SpiceOrder 6 
PIN 320 96 BOTTOM 8 
PINATTR PinName Ta 
PINATTR SpiceOrder 7 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 9 回路シンボルファイル 

“IGBT ショットキーバリアダイオード内蔵” 

シンボル： 

 

 

 

 

 

シンボルファイル名：IGBT-sbd.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 64 8 64 0 
LINE Normal 64 8 64 8 
LINE Normal 24 64 24 32 
LINE Normal 0 64 24 64 
LINE Normal 80 88 80 8 
LINE Normal 64 8 80 8 
LINE Normal 64 96 64 88 
LINE Normal 64 88 80 88 
LINE Normal 88 55 72 55 
LINE Normal 80 39 88 55 
LINE Normal 72 55 80 39 
LINE Normal 88 39 72 39 
LINE Normal 32 54 32 42 
LINE Normal 32 38 32 26 
LINE Normal 32 70 32 58 
LINE Normal 64 8 32 32 
LINE Normal 64 88 32 64 
LINE Normal 53 64 32 48 
LINE Normal 47 70 49 77 
LINE Normal 43 78 49 77 
LINE Normal 56 20 50 19 
LINE Normal 52 12 50 19 
LINE Normal 72 36 72 39 
LINE Normal 76 36 72 36 
LINE Normal 88 42 88 39 
LINE Normal 84 42 88 42 
WINDOW 0 96 32 Left 2 
WINDOW 3 96 72 Left 2 
SYMATTR Value RGxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM IGBT 
SYMATTR ModelFile xxxx.lib 
PIN 64 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 64 96 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 10 回路シンボルファイル 

“IGBT ショットキーバリアダイオード内蔵（電気-熱連成解析モデル）” 

シンボル： 

 

 

 

 

 

シンボルファイル名：IGBT-sbd-therm.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 64 8 64 0 
LINE Normal 64 8 64 8 
LINE Normal 24 64 24 32 
LINE Normal 0 64 24 64 
LINE Normal 80 88 80 8 
LINE Normal 64 8 80 8 
LINE Normal 64 96 64 88 
LINE Normal 64 88 80 88 
LINE Normal 88 55 72 55 
LINE Normal 80 39 88 55 
LINE Normal 72 55 80 39 
LINE Normal 88 39 72 39 
LINE Normal 32 54 32 42 
LINE Normal 32 38 32 26 
LINE Normal 32 70 32 58 
LINE Normal 64 8 32 32 
LINE Normal 64 88 32 64 
LINE Normal 53 64 32 48 
LINE Normal 47 70 49 77 
LINE Normal 43 78 49 77 
LINE Normal 56 20 50 19 
LINE Normal 52 12 50 19 
LINE Normal 72 36 72 39 
LINE Normal 76 36 72 36 
LINE Normal 88 42 88 39 
LINE Normal 84 42 88 42 
RECTANGLE Normal 352 96 160 16 
WINDOW 0 96 32 Left 2 
WINDOW 3 96 0 Left 2 
SYMATTR Value RGxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM IGBT 
SYMATTR ModelFile xxxx.lib 
PIN 64 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 64 96 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
PIN 192 96 BOTTOM 8 
PINATTR PinName Tjm 
PINATTR SpiceOrder 4 
PIN 256 96 BOTTOM 8 
PINATTR PinName Tjd 
PINATTR SpiceOrder 5 
PIN 352 32 RIGHT 8 
PINATTR PinName Tc 
PINATTR SpiceOrder 6 
PIN 320 96 BOTTOM 8 
PINATTR PinName Ta 
PINATTR SpiceOrder 7 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 11 回路シンボルファイル 

“ダーリントントランジスタ NPN” 

シンボル： 

 

 

 

 

 

シンボルファイル名：Darlington-NPN1.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 96 112 96 80 
LINE Normal 128 64 96 88 
LINE Normal 128 128 96 104 
LINE Normal 113 107 116 119 
LINE Normal 105 120 116 119 
LINE Normal 128 0 128 64 
LINE Normal 128 160 128 128 
LINE Normal 144 16 16 16 
LINE Normal 144 144 144 16 
LINE Normal 16 144 144 144 
LINE Normal 16 16 16 144 
LINE Normal 64 96 96 96 
LINE Normal 32 72 64 96 
LINE Normal 32 48 32 80 
LINE Normal 0 64 32 64 
LINE Normal 32 56 64 32 
LINE Normal 128 32 64 32 
LINE Normal 49 75 52 87 
LINE Normal 41 88 52 87 
WINDOW 0 150 64 Left 2 
WINDOW 3 150 96 Left 2 
SYMATTR Value 2SDxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM Darlington NPN BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 128 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 128 160 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 12 回路シンボルファイル 

“ダーリントントランジスタ NPN 抵抗内蔵” 

シンボル： 

 

 

 

 

 

 

シンボルファイル名：Darlington-NPN2.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 96 112 96 80 
LINE Normal 128 64 96 88 
LINE Normal 128 128 96 104 
LINE Normal 113 107 116 119 
LINE Normal 105 120 116 119 
LINE Normal 128 0 128 64 
LINE Normal 128 176 128 128 
LINE Normal 144 16 16 16 
LINE Normal 144 160 144 16 
LINE Normal 16 160 144 160 
LINE Normal 16 16 16 160 
LINE Normal 64 96 96 96 
LINE Normal 32 72 64 96 
LINE Normal 32 48 32 80 
LINE Normal 0 64 32 64 
LINE Normal 32 56 64 32 
LINE Normal 128 32 64 32 
LINE Normal 49 75 52 87 
LINE Normal 41 88 52 87 
LINE Normal 91 148 91 140 
LINE Normal 115 148 91 148 
LINE Normal 115 140 115 148 
LINE Normal 91 140 115 140 
LINE Normal 80 144 91 144 
LINE Normal 80 96 80 144 
LINE Normal 115 144 128 144 
TEXT 98 132 Left 1 R 
WINDOW 0 150 72 Left 2 
WINDOW 3 150 104 Left 2 
SYMATTR Value 2SDxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM Darlington NPN BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 128 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 128 176 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 13 回路シンボルファイル 

“ダーリントントランジスタ PNP” 

シンボル： 

 

 

 

 

 

シンボルファイル名：Darlington-PNP1.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 96 80 96 48 
LINE Normal 128 32 96 56 
LINE Normal 128 96 96 72 
LINE Normal 128 0 128 32 
LINE Normal 128 160 128 96 
LINE Normal 144 16 16 16 
LINE Normal 144 144 144 16 
LINE Normal 16 144 144 144 
LINE Normal 16 16 16 144 
LINE Normal 109 36 107 48 
LINE Normal 118 50 107 48 
LINE Normal 64 64 96 64 
LINE Normal 32 88 64 64 
LINE Normal 32 112 32 80 
LINE Normal 32 96 0 96 
LINE Normal 32 104 64 128 
LINE Normal 128 128 64 128 
LINE Normal 45 68 43 80 
LINE Normal 54 82 43 80 
WINDOW 0 148 64 Left 2 
WINDOW 3 148 96 Left 2 
SYMATTR Value 2SBxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM DIGITAL PNP BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 128 160 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 96 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 128 0 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 14 回路シンボルファイル 

“ダーリントントランジスタ PNP 抵抗内蔵” 

シンボル： 

 

 

 

 

 

 

シンボルファイル名：Darlington-PNP2.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 96 96 96 64 
LINE Normal 128 48 96 72 
LINE Normal 128 112 96 88 
LINE Normal 128 0 128 48 
LINE Normal 128 176 128 112 
LINE Normal 144 16 16 16 
LINE Normal 144 160 144 16 
LINE Normal 16 160 144 160 
LINE Normal 16 16 16 160 
LINE Normal 109 52 107 64 
LINE Normal 118 66 107 64 
LINE Normal 64 80 96 80 
LINE Normal 32 104 64 80 
LINE Normal 32 128 32 96 
LINE Normal 32 112 0 112 
LINE Normal 32 120 64 144 
LINE Normal 128 144 64 144 
LINE Normal 45 84 43 96 
LINE Normal 54 98 43 96 
LINE Normal 116 36 92 36 
LINE Normal 116 28 116 36 
LINE Normal 92 28 116 28 
LINE Normal 92 36 92 28 
LINE Normal 116 32 128 32 
LINE Normal 80 32 92 32 
LINE Normal 80 80 80 32 
TEXT 99 43 Left 1 R 
WINDOW 0 148 72 Left 2 
WINDOW 3 148 104 Left 2 
SYMATTR Value 2SBxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM DIGITAL PNP BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 128 176 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 112 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 128 0 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 15 回路シンボルファイル 

“デジタルトランジスタ NPN, R1 内蔵” 

シンボル： 

 

 

 

 

 

シンボルファイル名：DigitalTransistor-NPN1.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 80 80 80 48 
LINE Normal 112 32 80 56 
LINE Normal 112 96 80 72 
LINE Normal 97 75 100 87 
LINE Normal 89 88 100 87 
LINE Normal 112 0 112 32 
LINE Normal 56 60 32 60 
LINE Normal 56 68 56 60 
LINE Normal 32 68 56 68 
LINE Normal 32 60 32 68 
LINE Normal 0 64 32 64 
LINE Normal 80 64 56 64 
LINE Normal 112 128 112 96 
LINE Normal 128 16 16 16 
LINE Normal 128 112 128 16 
LINE Normal 16 112 128 112 
LINE Normal 16 16 16 112 
TEXT 34 48 Left 1 R1 
WINDOW 0 132 48 Left 2 
WINDOW 3 132 80 Left 2 
SYMATTR Value DTCxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM DIGITAL NPN BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 112 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 112 128 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 16 回路シンボルファイル 

“デジタルトランジスタ NPN, R 内蔵” 

シンボル： 

 

 

 

 

 

シンボルファイル名：DigitalTransistor-NPN2.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 64 80 64 48 
LINE Normal 96 32 64 56 
LINE Normal 96 96 64 72 
LINE Normal 81 75 84 87 
LINE Normal 73 88 84 87 
LINE Normal 96 0 96 32 
LINE Normal 44 104 44 80 
LINE Normal 52 104 44 104 
LINE Normal 52 80 52 104 
LINE Normal 44 80 52 80 
LINE Normal 96 112 48 112 
LINE Normal 96 144 96 96 
LINE Normal 112 16 16 16 
LINE Normal 112 128 112 16 
LINE Normal 16 128 112 128 
LINE Normal 16 16 16 128 
LINE Normal 48 80 48 64 
LINE Normal 48 104 48 112 
LINE Normal 64 64 0 64 
TEXT 28 91 Left 1 R 
WINDOW 0 116 48 Left 2 
WINDOW 3 116 80 Left 2 
SYMATTR Value DTCxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM DIGITAL NPN BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 96 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 96 144 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 17 回路シンボルファイル 

“デジタルトランジスタ NPN, R1 と R2 内蔵” 

シンボル： 

 

 

 

 

 

シンボルファイル名：.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 80 80 80 48 
LINE Normal 112 32 80 56 
LINE Normal 112 96 80 72 
LINE Normal 97 75 100 87 
LINE Normal 89 88 100 87 
LINE Normal 112 0 112 32 
LINE Normal 56 60 32 60 
LINE Normal 56 68 56 60 
LINE Normal 32 68 56 68 
LINE Normal 32 60 32 68 
LINE Normal 60 104 60 80 
LINE Normal 68 104 60 104 
LINE Normal 68 80 68 104 
LINE Normal 60 80 68 80 
LINE Normal 0 64 32 64 
LINE Normal 80 64 56 64 
LINE Normal 112 112 64 112 
LINE Normal 112 144 112 96 
LINE Normal 128 16 16 16 
LINE Normal 128 128 128 16 
LINE Normal 16 128 128 128 
LINE Normal 16 16 16 128 
LINE Normal 64 80 64 64 
LINE Normal 64 104 64 112 
TEXT 34 48 Left 1 R1 
TEXT 34 90 Left 1 R2 
WINDOW 0 132 48 Left 2 
WINDOW 3 132 80 Left 2 
SYMATTR Value DTCxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM DIGITAL NPN BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 112 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 112 144 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 18 回路シンボルファイル 

“デジタルトランジスタ NPN, R とツェナーダイオード内蔵” 

シンボル： 

 

 

 

 

 

 

シンボルファイル名：DigitalTransistor-NPN4.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 64 96 64 64 
LINE Normal 96 48 64 72 
LINE Normal 96 112 64 88 
LINE Normal 81 91 84 103 
LINE Normal 73 104 84 103 
LINE Normal 96 0 96 48 
LINE Normal 44 120 44 96 
LINE Normal 52 120 44 120 
LINE Normal 52 96 52 120 
LINE Normal 44 96 52 96 
LINE Normal 96 128 48 128 
LINE Normal 96 160 96 112 
LINE Normal 112 16 16 16 
LINE Normal 112 144 112 16 
LINE Normal 16 144 112 144 
LINE Normal 16 16 16 144 
LINE Normal 48 120 48 128 
LINE Normal 56 48 40 48 
LINE Normal 56 64 40 64 
LINE Normal 48 48 56 64 
LINE Normal 40 64 48 48 
LINE Normal 56 53 56 48 
LINE Normal 0 80 64 80 
LINE Normal 48 32 96 32 
LINE Normal 48 96 48 32 
TEXT 28 107 Left 1 R 
WINDOW 0 116 64 Left 2 
WINDOW 3 116 96 Left 2 
SYMATTR Value DTDGxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM DIGITAL NPN BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 96 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 80 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 96 160 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 19 回路シンボルファイル 

“デジタルトランジスタ NPN, R1 R2 とツェナーダイオード内蔵” 

シンボル： 

 

 

 

 

 

 

シンボルファイル名：.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 80 96 80 64 
LINE Normal 112 48 80 72 
LINE Normal 112 112 80 88 
LINE Normal 97 91 100 103 
LINE Normal 89 104 100 103 
LINE Normal 112 0 112 48 
LINE Normal 56 76 32 76 
LINE Normal 56 84 56 76 
LINE Normal 32 84 56 84 
LINE Normal 32 76 32 84 
LINE Normal 60 120 60 96 
LINE Normal 68 120 60 120 
LINE Normal 68 96 68 120 
LINE Normal 60 96 68 96 
LINE Normal 0 80 32 80 
LINE Normal 80 80 56 80 
LINE Normal 112 128 64 128 
LINE Normal 112 160 112 112 
LINE Normal 128 16 16 16 
LINE Normal 128 144 128 16 
LINE Normal 16 144 128 144 
LINE Normal 16 16 16 144 
LINE Normal 64 120 64 128 
LINE Normal 72 48 56 48 
LINE Normal 72 54 72 48 
LINE Normal 72 64 56 64 
LINE Normal 64 48 72 64 
LINE Normal 56 64 64 48 
LINE Normal 64 32 112 32 
LINE Normal 64 96 64 32 
TEXT 34 64 Left 1 R1 
TEXT 34 106 Left 1 R2 
WINDOW 0 132 64 Left 2 
WINDOW 3 132 96 Left 2 
SYMATTR Value DTDGxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM DIGITAL NPN BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 112 0 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 80 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 112 160 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 20 回路シンボルファイル 

“デジタルトランジスタ PNP, R1 内蔵” 

シンボル： 

 

 

 

 

 

シンボルファイル名：DigitalTransistor-PNP1.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 80 80 80 48 
LINE Normal 112 32 80 56 
LINE Normal 112 96 80 72 
LINE Normal 112 0 112 32 
LINE Normal 56 60 32 60 
LINE Normal 56 68 56 60 
LINE Normal 32 68 56 68 
LINE Normal 32 60 32 68 
LINE Normal 0 64 32 64 
LINE Normal 80 64 56 64 
LINE Normal 112 128 112 96 
LINE Normal 128 16 16 16 
LINE Normal 128 112 128 16 
LINE Normal 16 112 128 112 
LINE Normal 16 16 16 112 
LINE Normal 93 36 91 48 
LINE Normal 102 50 91 48 
TEXT 34 78 Left 1 R1 
WINDOW 0 132 48 Left 2 
WINDOW 3 132 80 Left 2 
SYMATTR Value DTAxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM DIGITAL PNP BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 112 128 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 64 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 112 0 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 21 回路シンボルファイル 

“デジタルトランジスタ PNP, R 内蔵” 

シンボル： 

 

 

 

 

 

シンボルファイル名：DigitalTransistor-PNP2.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 64 96 64 64 
LINE Normal 96 48 64 72 
LINE Normal 96 112 64 88 
LINE Normal 96 0 96 48 
LINE Normal 44 64 44 40 
LINE Normal 52 64 44 64 
LINE Normal 52 40 52 64 
LINE Normal 44 40 52 40 
LINE Normal 96 32 48 32 
LINE Normal 96 144 96 112 
LINE Normal 112 16 16 16 
LINE Normal 112 128 112 16 
LINE Normal 16 128 112 128 
LINE Normal 16 16 16 128 
LINE Normal 48 80 48 64 
LINE Normal 48 32 48 40 
LINE Normal 77 52 75 64 
LINE Normal 86 66 75 64 
LINE Normal 64 80 0 80 
TEXT 29 51 Left 1 R 
WINDOW 0 116 64 Left 2 
WINDOW 3 116 96 Left 2 
SYMATTR Value DTAxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM DIGITAL PNP BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 96 144 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 80 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 96 0 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 22 回路シンボルファイル 

“デジタルトランジスタ PNP, R1 と R2 内蔵” 

シンボル： 

 

 

 

 

 

 

シンボルファイル名：DigitalTransistor-PNP3.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType CELL 
LINE Normal 80 96 80 64 
LINE Normal 112 48 80 72 
LINE Normal 112 112 80 88 
LINE Normal 112 0 112 48 
LINE Normal 56 76 32 76 
LINE Normal 56 84 56 76 
LINE Normal 32 84 56 84 
LINE Normal 32 76 32 84 
LINE Normal 60 64 60 40 
LINE Normal 68 64 60 64 
LINE Normal 68 40 68 64 
LINE Normal 60 40 68 40 
LINE Normal 0 80 32 80 
LINE Normal 80 80 56 80 
LINE Normal 112 32 64 32 
LINE Normal 112 144 112 112 
LINE Normal 128 16 16 16 
LINE Normal 128 128 128 16 
LINE Normal 16 128 128 128 
LINE Normal 16 16 16 128 
LINE Normal 64 80 64 64 
LINE Normal 64 32 64 40 
LINE Normal 93 52 91 64 
LINE Normal 102 66 91 64 
TEXT 34 94 Left 1 R1 
TEXT 34 50 Left 1 R2 
WINDOW 0 132 64 Left 2 
WINDOW 3 132 96 Left 2 
SYMATTR Value DTAxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM DIGITAL PNP BJT model 
SYMATTR ModelFile xxxx.lib 
PIN 112 144 NONE 0 
PINATTR PinName C 
PINATTR SpiceOrder 1 
PIN 0 80 NONE 0 
PINATTR PinName B 
PINATTR SpiceOrder 2 
PIN 112 0 NONE 0 
PINATTR PinName E 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 23 回路シンボルファイル 

“GaN HEMT 3pin” 

シンボル： 

 

 

 

 

 

シンボルファイル名：GaNhemt-3.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType BLOCK 
LINE Normal 32 38 32 26 
LINE Normal 32 54 32 42 
LINE Normal 32 70 32 58 
LINE Normal 64 32 32 32 
LINE Normal 64 64 32 64 
LINE Normal 64 32 64 0 
LINE Normal 64 64 64 96 
LINE Normal 32 48 0 48 
LINE Normal 24 48 16 42 
LINE Normal 16 54 24 48 
WINDOW 3 80 64 Left 2 
WINDOW 0 80 32 Left 2 
SYMATTR Value GNExxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM GaN HEMT 
SYMATTR ModelFile xxxx.lib 
PIN 64 0 NONE 8 
PINATTR PinName D 
PINATTR SpiceOrder 1 
PIN 0 48 NONE 8 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 64 96 NONE 8 
PINATTR PinName S 
PINATTR SpiceOrder 3 
----ここまで---------------------------------- 
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2025.3 

Application Note LTspice モデルの使い方 

付録 24 回路シンボルファイル 

“GaN HEMT 4pin” 

シンボル： 

 

 

 

 

 

シンボルファイル名：GaNhemt-4.asy 

テキストデータ： 

----ここから---------------------------------- 
Version 4 
SymbolType BLOCK 
LINE Normal 32 38 32 26 
LINE Normal 32 54 32 42 
LINE Normal 32 70 32 58 
LINE Normal 64 32 32 32 
LINE Normal 64 64 32 64 
LINE Normal 64 32 64 0 
LINE Normal 64 64 64 96 
LINE Normal 32 48 0 48 
LINE Normal 32 96 64 64 
LINE Normal 32 96 0 96 
LINE Normal 24 48 16 42 
LINE Normal 16 54 24 48 
WINDOW 3 80 64 Left 2 
WINDOW 0 80 32 Left 2 
SYMATTR Value GNPxxxx 
SYMATTR Prefix X 
SYMATTR Description ROHM GaN HEMT 
SYMATTR ModelFile xxxx.lib 
PIN 64 0 NONE 8 
PINATTR PinName D 
PINATTR SpiceOrder 1 
PIN 0 48 NONE 8 
PINATTR PinName G 
PINATTR SpiceOrder 2 
PIN 0 96 NONE 8 
PINATTR PinName KS 
PINATTR SpiceOrder 3 
PIN 64 96 NONE 8 
PINATTR PinName S 
PINATTR SpiceOrder 4 
----ここまで---------------------------------- 
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本資料に記載されている内容は、ロームグループ（以下「ローム」という）製品のご紹介を目的としています。ローム製品
のご使用にあたりましては、別途最新のデータシートもしくは仕様書を必ずご確認ください。

ローム製品は、一般的な電子機器（AV機器、OA機器、通信機器、家電製品、アミューズメント機器等）もしくはデータ
シートに明示した用途への使用を意図して設計・製造されています。したがいまして、極めて高度な信頼性が要求され、
その故障や誤動作が人の生命、身体への危険もしくは損害、またはその他の重大な損害の発生に関わるような機器ま
たは装置（医療機器、輸送機器、交通機器、航空宇宙機器、原子力制御装置、燃料制御、カーアクセサリーを含む車載機
器、各種安全装置等）（以下「特定用途」という）にローム製品のご使用を検討される際は事前にローム営業窓口までご
相談くださいますようお願いいたします。ロームの文書による事前の承諾を得ることなく、特 定用途にローム製品を使
用したことによりお客様または第三者に生じた損害等に関し、ロームは一切その責任を負いません。

半導体を含む電子部品は、一定の確率で誤動作や故障が生じる場合があります。万が一、誤動作や故障が生じた場合で
あっても、人の生命、身体、財産への危険または損害が生じないように、お客様の責任においてフェールセーフ設計など
安全対策をお願いいたします。

本資料に記載された応用回路例やその定数などの情報は、ローム製品の標準的な動作や使い方を説明するためのも
ので、実際に使用する機器での動作を明示的にも黙示的にも保証するものではありません。したがいまして、お客様の
機器の設計において、回路やその定数及びこれらに関連する情報を使用する場合には、外部諸条件を考慮し、お客様の
判断と責任において行ってください。これらの使用に起因しお客様または第三者に生じた損害に関 し、ロームは一切そ
の責任を負いません。

ローム製品及び本資料に記載の技術を輸出または国外へ提供する際には、「外国為替及び外国貿易法」、「米国輸出管
理規則」など適用される輸出関連法令を遵守し、それらの定めにしたがって必要な手続きを行ってください。

本資料に記載された応用回路例などの技術情報及び諸データは、あくまでも一例を示すものであり、これらに関する第
三者の知的財産権及びその他の権利について権利侵害がないことを保証するものではありません。また、ロームは、本
資料に記載された情報について、ロームもしくは第三者が所有または管理している知的財産権その他の権利の実施、
使用または利用を、明示的にも黙示的にも、お客様に許諾するものではありません。

本資料の全部または一部をロームの文書による事前の承諾を得ることなく転載または複製することを固くお断りいた
します。

本資料に記載の内容は、本資料発行時点のものであり、予告なく変更することがあります。ローム製品のご購入及びご
使用に際しては、事前にローム営業窓口で最新の情報をご確認ください。

ロームは本資料に記載されている情報に誤りがないことを保証するものではありません。万が一、本資料に記載された
情報の誤りによりお客様または第三者に損害が生じた場合においても、ロームは一切その責任を負いません。

ローム製品のご検討ありがとうございます。
より詳しい資料やカタログなどご用意しておりますので、お問い合わせください。
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